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GstarCAD 2025 Complete Guide

Elevating Performance, Empowering Design

GstarCAD 2025 elevates performance to a new level with Hardware Acceleration and other improvements on a series of features,
significantly enhances the design experience. Exciting new features, including Parametric Constraints, BIM Data Editing, and Voice
Annotation, etc., further enrich functionality. What's more, compatibility has been expanded with the addition of Python support,
empowering more robust customization and automation. Without further ado, let's explore these exciting updates!

1.  Excellent Performance

Higher performance plays an important role in GstarCAD. GstarCAD not only constantly provides users with more useful functions, but
also delivers great performance in both 2D and 3D operations.

The performance of commonly-used operations like "OPEN", "QSAVE", "PLOT", "CLIP", "TRIM", "PASTE", "MOVE", "DYNAMIC SELECTION",
and more commands are significantly faster than other CAD software. Large drawings could be opened more quickly and your work can
be saved in only a fraction of a second.

The chart below provides an overview of the performance of GstaCAD 2025. We built an operation speed comparison of the basic
features between GstarCAD and other CADs. Two drawings were used to test the operation time, one was around 48 MB and another was
around 114 MB. To make sure the data validation, the same operations were tested twice and got the average value.

Operation Response Time Operation Response Time
Comparison Comparison
Open ™™ Open W™
Move ™ Move [I—
Regen WP Undo ™=
Undo I Redo [HIF
Mirror ™ Mirror I
CTRL+C CTRL+C
W GstarCAD 2024  m GstarCAD 2025 W ACAD 2025 m GstarCAD 2025

Testing Environment: WIN10 64bit; 16G storage; CPU: Intel i5-4430  Testing Environment: WIN11 64bit; 16G storage; CPU: Intel i7-1165G7



Operation Response Time Operation Response Time

Comparison Comparison

Open ™™ Open W

Move I Move ™

Undo ™ Save ™

Redo ™ Regen IF
Regen ™= Mirror
Mirror I CTRL+C

B ZCAD 2025 m GstarCAD 2025 B BCAD 2024 m GstarCAD 2025

Testing Environment: WIN10 64bit; 16G storage; CPU: Intel i5-10400  Testing Environment; WIN11 64bit; 16G storage; CPU: Intel i5-11400

[t's obvious that GstarCAD 2025 is faster than other CAD software when executing OPEN, MOVE, UNDO, REDO, MIRROR, REGEN,
SAVEAS and CTRL+C commands. And it is extremely good when executing COPY TO CLIPBOARD command. Besides the chart,
GstarCAD also works excellently in ARRAY and EXPLODE commands, while the other CADs couldn’t even array objects in the same
drawing. Additionally, executing EXPLODE with the other CAD software wouldn't get a response for a long time. Compared with other
CAD software, GstarCAD is far ahead in performance, especially when it comes to large drawings.

2. Perfect Compatibility

GstarCAD delivers high compatibility with ACAD and provides robust APIs. The seamless data format, familiar interface, command
structure and user operating habit ensure an easy transition, while the powerful APIs allow for extensive customization and automation,
empowering you to tailor the software to your specific needs.

>  Data Format

GstarCAD 2025 supports the native DWG/DXF file formats which are completely compatible with ACAD from version 2.5 to 2024.
Any CAD drawings based on the DWG/DXF format can be easily processed by GstarCAD. Meanwhile, the drawings created by
GstarCAD also can be processed by other CAD software. GstarCAD 2025 fully realizes bidirectional compatibility with ACAD in
data formats.

Furthermore, GstarCAD 2025 even supports various kinds of data file formats and application development interfaces. You could
create or edit drawings in completely original ways.
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The main file formats and development interfaces between GstarCAD and ACAD.

ACAD

DWG Drawings v ‘ G EE] View v

Name - Date modified Type 2

G Drawingl.dwg 5/14/2024 11:28 PM DWG File

G Drawing2.dwg 5/14/2024 11:28 PM DWG File

G Drawing3.dwg 5/14/2024 11:28 PM DWG File

Options...
AutoCAD 2013(LT2013) Drawing(*.dwg) Security Options...
AutoCAD 2010(LT2010) Drawing(*.dwg)
AutoCAD 2007(LT2007) Drawing(*.dwg)
AutoCAD 2004(LT2004) Drawing(*.dwg)
AutoCAD 2000(LT2000) Drawing(*.dwg)
AutoCAD R14(LT98/LT97) Drawing(*.dwg)
AutoCAD DrawingStandard(".dws)
AutoCAD DrawingTemplate(*.dwt)
AutoCAD 2018 DXF(".dxf)
AutoCAD 2013(LT2013) DXF(*.dxf)
AutoCAD 2010(LT2010) DXF(".dxf)
—— Auto CAD 2007(LT2007) DXF(*.dxf)
AutoCAD 2004(LT2004) DXF(*.dxf)
File name: AutoCAD 2000(LT2000) DXF(*.dxf)
AutoCAD R12/LT2 DXF(".dxf)
Save as type: AutoCAD 2018 Drawing(*.dwg) v Cancel

2.5-2018 DWG/DXF Versions

<

Drawing Template File (DWT)

Drawing standard File (DWS)

Customize User interface file (CUI/CUIX)

0ld Menu File (MNU)

Drawing Sheet Set File (DST)

Hatch Pattern File (PAT)

Font File (SHX)

Line Type File (LIN)

Print Style File (CTB/STB)

Import and Export WMF

Import and Export SAT

Import 3DS

Import DGN

Export DWF/DWFX

Export STL

Export EMF

DWF Underlay

PDF Underlay

DGN Underlay

Script File (SCR)

LISP Development Interface

LSP File Loading

FAS File Loading

VLX File Loading

AN S A R A A Y Y A A Y A Y A Y Y Y Y A Y A YRR

AR N N Y S Y Y Y A Y A A A Y A Y Y A A A YRR




VBA Development Interface v 4
Class ARX Development Interface v v
.net Development Interface v 4

Concise User Interface

GstarCAD 2025 offers you a concise and familiar interface. The combination of attractive dark color theme and icon designs helps
reduce your eyestrain. It's also available for you to display and rearrange elements like the toolbars, display the command bar,
switch between workspaces, change the interface themes, customize your own interface and enable the status bar. The toolbars
and command bar can also be floated anywhere on the screen or docked as well.

Familiar Command

You can get started with GstarCAD immediately with the familiar command structure and shortcut system that you have known
without extra learning. Whether you're a novice user or an experienced CAD professional, you can quickly start creating drawings
using the productivity-enhancing features of GstarCAD.

GstarCAD Commands ACAD Commands GstarCAD Commands ACAD Commands
Multiple Multiple Superhatch Superhatch
Osnap Osnap Redraw Redraw
Qselect Qselect Regen Regen
Qleader Qleader Scalelistedit Scalelistedit
Spell Spell Bedit Bedit




Layerp Layerp Render Render
Layoff Layoff Flatshot Flatshot

»  Customized Settings

GstarCAD offers several methods to import your customized settings such as CUI, Lisp program, Shortcut settings, Blocks, DWT,

Tool palettes, Plotters and more from other CAD software. In just a few minutes, you can recreate the interface that you’re familiar
with in GstarCAD.

> APl and Add-ons

GstarCAD offers friendly development interfaces such as Python, GRX, .NET, VBA, Lisp, COM, etc. Nowadays, hundreds of
professional applications and industrial solutions are running on GstarCAD.

For more information about applications/add-ons of GstarCAD, please refer to the link:

https://www.gstarcad.net/application/

3. Flexible Licensing

3.1, Licensing Policy

GstarCAD’s licensing policy is flexible and simple. We provide both perpetual license and subscription. You are free to choose the
license mode and you decide when to upgrade.

> Perpetual License

When you choose to buy GstarCAD Perpetual License, you have the right to use it perpetually. Buy it once and it's forever yours.
You are not forced to buy the subscription or upgrades.

> Perpetual License and Subscription Plans

You can buy GstarCAD Perpetual License together with Subscription Plans. Gstarsoft releases a new GstarCAD major version every
year, with Subscription Plans you can upgrade to the latest version of GstarCAD.

> Yearly Subscription

GstarCAD Yearly Subscription is similar to ACAD Subscription; you can just pay a smaller amount for GstarCAD’s 1-year license.
7



https://www.gstarcad.net/application/

> GstarCAD Upgrades

Gstarsoft releases a new GstarCAD major version every year; you can upgrade your GstarCAD Perpetual License to the Perpetual
License of any newer version!

3.2. Licensing Options

GstarCAD not only provides a flexible licensing policy, but also provides flexible licensing Options. GstarCAD offers Stand-alone and
Network licenses, both are available with Soft key (Serial number) and Dongle (USB-key).

® Stand-alone license

The software is constrained to a certain host. A license is needed for each computer on which the software will be installed.

® Network license

A pool of licenses is available on the server, for users of any computers on the network. You only need to have licenses for the
maximum number of simultaneous users expected, not for each computer where the software will be installed.

Stand-alone Stand-alone Network Network

License-key Serial number = USB-key Dongle  License-key Serial number = USB-key Dongle

Perpetual license v

Rental license

V
License borrowing v
v

Connection to license server
\

4. Innovative Features

GstarCAD offers over 100 unigue and innovative tools like “Collaboration”, “Area Table”, “Auto Layer”, “Viewport to Layout”, and
“Autoxlstable”. They are adopted to significantly speed up your drafting speed.

GstarCAD Innovative Description

Features

Autolayer Automatically switch the current layer while drawing the graph and draws the
graphic to the set layer.
Automatically dimension and count the area of an enclosed object and export the
result to a table in the current drawing area.
Break Object Breaks Objects by intersecting lines and allows to set the gap.

8
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Block Break

Breaks or shelters the graphic under the block.

Graphic Compare

Compares graphic of two groups of objects or two files.

Line2pl Converts one or multiple connected straight line(s), arc(s) to one polyline.
Spiol The spline created can be converted to a polyline according to the accuracy
(number of segments of the arc).
A set of GstarCAD practical tools to enhance design efficiency, Including Drawing
GstarCAD Tools

Scale, Rotate Cursor, Draw Axonometric Line, Extension, Normal Connect, etc.

Drawing Lock

Turns the drawing into a whole block to prevent being modified by others.

Attribute Increment

Specifies attribute of blocks with incremental value, and modifies attribute value of
blocks according to the sort method.

Define Layout Viewport from

Model Space (M2LVPORT)

Defines the range of drawing displayed in the viewport from the model space,
calculates the viewport size based on the set scale and positions the viewport in the
layout space.

Aligns selected objects such as rectangle, circle, line, spline, arc, pline, block and

Align Tool . . .

even 3D model object along X or Y axis coordinates.

Adjusts the arrangement of multiple objects. It can align multiple objects at left,
Arrange Tool _ .

right, top, bottom and center and also can arrange vertically or laterally.
MEASUREGEOM Supports measuring distance, radius, angle, area, volume sum area and so on.

Symmetric Draw

Generates the symmetrical object automatically when drawing an object.

Outline Objects

Extracts the outline shape of selected closed objects in a window selection method.

The FILLET command now offers a new option called Invert. You can create a reverse

Invert Fillet
fillet with this option.
Maanifier Views a specific area of your drawing as a magnifier with the capability of snap
g points without performing zoom in/out.
Barcode & QR Code Creates Barcode & QR Code by entering data or picking data from drawings.
Shortcut The CUSTACC command allows you to customize, delete or modify existing
Customization(CUSTACC) command shortcuts.
A set of practical tools to draw and edit tables and can export CAD tables to Excel
Table Tools ,
files.
AtoXLSTable Opens Excel file to edit the Fjata and mse.rt. it into GstarCAD. It also allows updating
the table data after the drawing was modified.
, Supports different Boolean operation options such as union, intersection and
Pline Boolean ,
subtraction.
Batch Print Batch print drawings with the same drawing frame attribute in a drawing.

Arrange Frame

Inserts frames of drawings, calculates according to the size of the frame and then
arranges them to a big drawing.

GstarCAD Collaboration

Helps to improve project design efficiency and significantly reduce error and cost.




5. What's New in GstarCAD 2025

5.1. Parametric Constraints New

GstarCAD 2025 introduces Parametric Constraints, focusing exclusively on geometric constraints this year. Geometric
constraints manage how objects relate to others, enabling automatic adjustments to other objects when changes are made.

There are 12 types of geometric constraints corresponding to 12 relationships: Coincident, Collinear, Concentric, Fix,
Parallel, Perpendicular, Horizontal, Vertical, Tangent, Smooth, Symmetric, and Equal.

Note: This feature is only available in the GstarCAD 2025 Plus version.

== x 2D Drafting 2 GstarCAD 2025 Plus - [Drawing1.dwg]

Home Insert Annotation 3D Surface Mesh Layout View Manage Export Help Collaboration BIM Express Parametric Application
2 Show/Hide
¢ 7 4| @ showAll

@ Hide Al L
Constraints

Geometric ™ [ELELT

(1) Coincident: Constrains two points to coincide, or a point to lie anywhere on an object or the extension of an object.

o

> Access: Click Ribbon » Parametric » Geometric » = or enter GCCOINCIDENT command.
»  Command Prompts:
®  Select the first point or [Object]: Select the first point or object that needs to coincide.
®  Select the second point or [Object]: Select the second point or object that coincides with the first point or object.

> Example:

(2) Collinear: Constrains two lines to lie on the same infinite line.
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> Access: Click Ribbon = Parametric » Geometric » or enter GCCOLLINEAR command.
> Command Prompts:
®  Select the first object or [Multiple]: Select the first object orc multiple objects that need to be collinear;

®  Select the second object or [Multiple]: Select one or multiple objects that are collinear with the first object or the
group of objects.

»  Example:

(3) Concentric: Constrains selected circle, arcs, or eclipses to maintain the same center point.

> Access: Click Ribbon » Parametric » Geometric » |:‘~—f':| or enter GCCONCENTRIC command.
»  Command Prompts:

®  Select the first object: Select the first object that needs to be concentric;

®  Select the second object: Select the second object that is concentric with the first object.

> Bxample:

(4) Fix: Constrains a point or a curve to a fixed location and orientation relative to the World Coordinate System.

11



> Access: Click Ribbon = Parametric » Geometric » m or enter GCFIX command.
> Command Prompt:
@  Select point or [object]: Select the point or object that needs to be fixed:;

> bample:

£l

463.496) '/
- .~ Specify stretch pointor =

s

(5) Parallel: Constrains two lines to maintain the same angle.

> Access: Click Ribbon » Parametric » Geometric » 7 or enter GCPARALLEL command.
»  Command Prompts:

®  Select the first object: Select the first object that needs to be parallel;

®  Select the second object: Select the second object that is parallel with the first object.

> Bxample:

(6> Perpendicular: Constrains two lines, or polyline segments to maintain a 90-degree angle to each other

12



X or enter GCPERPENDICULAR command.

> Access: Click Ribbon » Parametric » Geometric »
> Command Prompts:
®  Select the first object: Select the first object that needs to be perpendicular;

® Select the second object: Select the second object that is perpendicular with the first object.

»  Example:

(7) Horizontal: Constrains a line or pairs of points to lie parallel to the X-axis of the current UCS.

> Access: Click Ribbon » Parametric » Geometric > ~~~ or enter GCHORIZONTAL command.
»  Command Prompts:
® Select an object or [2Points]: Select the object or two points that needs to be parallel to the X-axis.

> Bxample:

(8) Vertical: Constrains lines or pairs of the points to lie parallel to the Y-axis of the current UCS.

13



> Access: Click Ribbon » Parametric » Geometric » -1 or enter GCVERTICAL command.
> Command Prompts:
® Selectan object or [2Points]: Select the object or two points that needs to be parallel to the Y-axis.

> bample:

(9) Tangent: Constrains two curves to maintain a point of tangency to each other or their extensions.

> Access: Click Ribbon » Parametric » Geometric » '1:___,1' or enter GCTANGENT command.
»  Command Prompts:

®  Select the first object: Select the first object that needs to be tangent;

®  Select the second object: Select the second object that is tangent with the first object.

> Bxample:

(10> Smooth: Constrains a spline to be contiguous and maintain G2 continuity with another spling, line, arc, or polyline.

14



> Access: Click Ribbon = Parametric » Geometric » or enter GCSMOOTH command.

> Command Prompts:

®  Select the first spline curve: Select the first object that needs to be smoothed:;

®  Select the second object: Select the second object that satisfies G2 continuity with the first object.

»  Example:

(11> Symmetric: Constrains two curves or points on objects to maintain symmetry about a selected line.

|
> Access: Click Ribbon = Parametric » Geometric » |:I or enter GCSYMMETRIC command.

»  Command Prompts:

®  Select the first object or [2Points]: Select the first object that needs to be parallel;

®  Select the second object or [2Points]: Select the second object that is parallel with the first object.
®  Select symmetry line: Select the axis of symmetry.

> Bxample:

15



(12) Equal: Constrains two lines or polyline segments to maintain equal lengths, or arcs and circles to maintain equal
radius values

> Access: Click Ribbon » Parametric > Geometric > o enter GCEQUAL command.
> Command Prompts:
®  Select the first object or [Multiple]: Select the first object(s) that need(s) to be equal;
®  Select the second object or [Multiple]: Select the object(s) equal to the first object.

»  Example:

) Show/Hide
| Show All =

@ Hide Al Delcte
Constraints

Geometric M Manage

. Show/Hide (CONSTRAINTBAR): Select objects to display or hide their associated geometric constraints.

= Show All Display all geometric constraints.

= Hide All: Hide all geometric constraints.

X Delete Constraints (DELCONSTRAINT): Delete all constraints that are associated with the selected objects.

L4l
“““Constraint Settings (CONSTRAINTSETTINGS): Manage settings related to constraints

16



(> Constraint Settings X

Infer geometric constraints

Constraint bar display settings

X Perpendicular “ Parallel selectal
e Horizontal 1 @ Vertical Clear All
o Tangent b Smooth (G2)

¥ @ Collinear © Concentric

£ Symmetric = Equal

i @coincident & Fix

Only display constraint bars for objects in the current plane

Constraint bar ransparency

50 [}

Show constraint bars after applying constraints to selected objects

Show constraint bars when objects are selected

( 0K Cancel Help

Note: You can also use GEOMCONSTRAINT command to establish or maintain geometric

' ' . : . Enter constraint type
relationships between objects or points on objects.

Horizontal
The order and selection points of objects can influence their relative positions when Vertical :
applying a geometric constraint to a pair of objects. Perpendicular
PArallel
Each option of this command corresponds to an individual command from (1) to (12). Tangent

SMooth
Coincident
CONcentric
COLlinear

Symmetric
Equal
Parametric Constraint Related System Variables Fix

System Variable Description Value Value Description

Automatically hides constraint bars

0 after applying geometric constraints.
Controls the display of constraints bars for , _ _
. _ Displays constraint bars when objects
subsequently applied geometric 1 wricall irained
_ , are geometrically constrained.
CONSTRAINTBARDISPLAY constraints, as well as the display of
hidden constraints for selected objects. Displays any hidden constraints, but
2 only if the constrained objects are

selected.

17



Horizontal

1
9 Vertical
4 Perpendicular
8 Parallel
16 Tangent
Controls the display of geometric S )
constraints on constraint bars. Setting it as 32 moot
CONSTRAINTBARMODE 4095 could display constraint bars for all .
. 64 Coincident
constraint types
198 Concentric
956 Collinear
519 Symmetric
1004  Equal
2048 Fix
Controls whether the geometric constraints 0 Off
CONSTRAINTINFER are inferred while creating and editing
geometry. 1 Geometric constraints are inferred
0 Name (for example, Width)
Controls the text format for dimensional ’ Value (for example, 4.0000)
CONSTRAINTNAMEFORMAT constraints.
Expression (for example, width =
2 4.0000)
Does not maintain the geometry’s size
0 - . .
Controls constraint behavior when applying when a constraint is applied or edited
CONSTRAINTSOLVEMODE i i
or editing constraints. Maintain of the geometry’s size when a
1 constraint is applied or edited
, The valid value ranges from 10 to 90.
Controls the transparency of the constraint , _
CBARTRANSPARENCY 50 Higher value makes the constraint bars

bars.

more opaque.
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5.2.

Hardware Acceleration New

In our daily use, we often need to process and compute image data.

However, the CPU, with its numerous tasks, cannot meet our speed
requirements for image processing and calculations sometimes.
Therefore, in GstarCAD 2025, we have introduced Hardware
Acceleration. This feature leverages the GPU, which excels at handling
images, to assist the CPU, thereby enhancing graphic display quality
and work efficiency, and improving overall performance. Enabling
hardware acceleration provides more efficient, high-quality real-time
display effects compared to the CPU, and offers better highlight effects.

Hardware Acceleration can automatically determine whether to activate based on the
user's hardware configuration. It can also be manually controlled using the command
GRAPHICSCONFIG, or by clicking the Performance Settings icon in the status bar.

>

G Graphics Performance X

Hardware configuration

Graphics Card : NVIDIA GeForce RTX 2050
DriverVersion : 310152919
OpenGL Version : 4.6.0

Graphical Display Settings

Hardware Acceleration  LEE5S

Take advantage ofthe GPU to optimize graphics rendering efficiency.If
compatibility issues arise, tun off hardware acceleration and then retry.

Smooth Line Display

Remove jagged edges from the graphic for a smoother graphic display.

Ok Cancel Help({H)

Hardware Configuration:

Displays the current user's hardware environment, including the Graphics Card, Driver Version, and OpenGL version information.

Graphics Display Settings:

Hardware Acceleration: Enable to activate Hardware Acceleration, using GPU for optimized graphics rendering. If disabled, the mode

switches to the default "Software Mode”.

Smooth Line Display: Removes jagged edges from the graphic for a smoother display.

19



System Variable Description Value Value Description

Indicates whether Hardware Acceleration is 0 Disabled
HARDWAREACCELERATE enabled or disabled. (Read-only)
1 Enabled

Note: If hardware acceleration cannot be enabled, it may be due to the hardware environment not meeting the requirements:
> OpenGL version below 4.2 or outdated driver version. You can try upgrading the system's graphics driver.
> If you encounter compatibility or performance issues, you can try disabling hardware acceleration.

> To ensure the best software experience, Windows 7 and earlier versions of the operating system are not supported.

If your system has dual graphics cards (dedicated and integrated), it is recommended to manually set the high-performance graphics
card to achieve better display performance. The method to set the high-performance graphics card depends on the graphics card model
and its corresponding software and driver version. Taking Windows 11 as an example, the manual setting method is as follows:

»  Right-click on the desktop and select "Display settings".
»  In"Display settings", find "Graphics".

> Onthe "Graphics" page, under "Custom options for apps", click "Browse", find gcad.exe in the installation path, and add it to the
list.

»  Click on the GstarCAD application in the list and then click "Options".

» Inthe Graphics preference dialog box, select "High performance" and click save.

Compared to the previous version, GstarCAD 2025 shows improved display effects in the following areas:

5.2.1. Highlight Display

Hardware Acceleration provides clearer highlighting effects, marking selected objects more distinctly. This allows users to identify,
select, and operate more accurately, enhancing the user experience.

20



System Variable Description Value Value Description
Controls the highlight display mode of 0 Dashed lines
SELECTIONEFFECT selected objects when Hardware
Acceleration enabled 1 Blue glowing line highlighting effect
Sets the color of the glowing highlighting
effect when objects are selected
0 Valid values are from 0 to 255

SELECTIONEFFECTCOLOR  Note: 0nly applies when SELECTIONEFFECT
is setto 1.

21




5.2.2.  Basic Visual Styles Support

Added support for two visual styles: Conceptual and X-ray:
> Conceptual Visual Style: Typically used in the early design stages, this style makes the graphics appear simpler.
> X-ray Visual Style: Allows for a clearer view of the relationships between objects.

These visual styles control the display of drawings, making objects clearer and improving drawing efficiency.

Conceptual X-ray

5.2.3.  Lighting Improvements

We have also optimized lighting, making the effects softer and allowing adjustments based on real-time preview. Key improvements
include:

»  Point Light: Provides uniform illumination in all directions, suitable for simulating indoor lighting or general ambient lighting.
> Spotlight: Concentrates light in a small area, ideal for highlighting specific objects or emphasizing focal points.

> Web Light: Displays the range or area formed by the light, simulating the radiation range of light.

> Target Point Light: Specifies a point as the light source, commonly used to simulate a light bulb or flame.

> Free Web: llluminates the surrounding environment without being blocked by surrounding objects.

Hardware Acceleration OFF Hardware Acceleration ON
22



5.3. 3D Mouse Device Adaption New
3Dconnexion is an international manufacturer of 3D mouse
devices. GstarCAD 2025 version supports 3Dconnexion's
SpaceMouse and CadMouse. Including using the controller's
joystick to switch views, executing commands and switching
views quickly via mouse shortcuts, and customizing mouse
buttons configurations within the driver software.

Knob and Joystick: The 3D mouse allows for combined
operations of pushing and pulling with the central knob
joystick, enabling zooming and panning in 2D views and
perspective adjustments in 3D views.

Shortcut Buttons: Configurable shortcut buttons on the 3D
mouse facilitate certain CAD and Windows functions.

i
(> GstarCAD

D DN DO A W M S

SpaceMouse Enterprse
® Box
Hlipse, Center
W Hatch
Line
Xune
<) Dimension, Radus
& cone
Arc
W yde Apps
') undo
 Redo

T Select Al

Dsable On-Screen Dsplay

QJ 30connexion

X

&

B s EscKey Vi 7] 3Dconnexion Vi Restore

TAB A TabKey Vim ) 30connexion V1 Save

ST O Shift Key V2 (i) connexion V2 Restore

om | 8 orlkey Ve [ 0conmexon V2 Save

AT AT ARKey va [ 2Dconnexion V3 Restore

— Space Key 3Dconnexion V3 Save

a= o EnterKey T Roll View +90

oy G

CEETE i Delete Key 3" Roll View -90

VENU 3 Properties.. D Top view
(& Bottom view
[ Front View

« (M Back View
Right View
) Left View

Rotation On/Off

S EBEEREBE

() 1501 View

@ 1502View

FIT 8, m

Restore Defaults Close

System Variable Description Value Value Description
The mouse cursor will follow the original
o GCAD logic and change to the crosshair
Controls whether the mouse cursor is in the 0 - . .
, . style when positioned in the drawing
GCAD drawing crosshair style. (The value of area
CURSORTYPE th|§ system va.rlable 's not stored in t.he The mouse cursor will remain as the
registry and will be reset after restarting the .
Windows system arrow style when
CAD software.) "y . . .
1 positioned in the drawing area, and will
not change according to the default
GCAD style.
5.4. Voice Annotation New

You can enter VOICEMANAGER or click Menu Bar > Tools » VoiceManager to add voice annotations in GstarCAD 2025, enhancing
clarity. Through the Voice Manager panel, you can easily create, record, play, and manage voice annotations.

23




+ @ =

New Hide All Lists Settings Close

5.4.1. Create Voice Annotation

Click the "New" button to create a voice annotation on the drawing.
Command prompt: Specify insertion point or [Object (0)/Range (R)/Speaker (S)]:
> Point: Specify an absolute point location to generate a voice annotation.

> Object: Select an object to bind the voice annotation to it. Only one object can be bound at a time, suitable for annotating a single
object with voice.

> Region; Select a region to bind the voice annotation. Only one region can be bound at a time, suitable for annotating multiple
objects with voice.

> Speaker: Edit the name of the speaker for this voice annotation.

54.2. Record

There are three modes when recording: Standby, Error, and Working.
> Recording Mode - Standby

After creating a voice annotation, the voice annotation panel is activated. At this point, the color of the record button changes from gray
to red. Click this button to start recording.

+ @® = O

New Hide All Lists Settings Close

> Recording Mode - Error

When the user's microphone device encounters an error or permissions are disabled, the record button will turn into a cautionary yellow
color. On the right side of the button, there will be a "Retry Detection" option. In this scenario, the recording cannot proceed. Users need
to manually check if there are any issues with the microphone and ensure that microphone permissions are correctly enabled to restore
recording functionality.
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"Retry Detection™: Click this button to recheck your recording environment. Once the user successfully troubleshoots the issue, the
system will automatically switch to working mode, ready to start recording at any time.

+ @

New Hide All Lists Settings

> Recording Mode - Working
"Reset Voice": Allows for retaking the current voice annotation.

"Delete Voice": Deletes the recorded voice and its associated objects.

+ @

New Hide All Lists Settings

543. Play

> Play Mode - Standby

+ @ O

New Hide All Lists Settings

> Play Mode - Play

+ @ ®;

New Hide All Lists Settings
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54.4. Manage

+ @® = O

New Hide All Lists Settings Close

> Hide All: By default, all voice objects on the drawing are visible. Users can manually choose to hide all voice objects. Note that
even if all voice objects are hidden before closing the drawing, the system will automatically restore all voice objects to their
default visible state when reopening the drawing. Any hiding actions performed before closing the drawing will not be retained.

> Lists: Displays a pop-up voice annotation list for viewing and management. Supports filter, delete, position and retake.

+ ® O X

New Hide All Lists Settings Close

%@

GstarCAD 00:10  point 2024/05/26 00:14 @ &
GstarCAD 00:06 range 2024/05/26 00:14
GstarCAD 00:14 object 2024/05/26 00:15

® 1 - Filter: Supports filtering by point, region and object types. Users can customize the voice annotations displayed in the list.
® 2 -Delete: Deletes the selected voice annotation.

® 3 -Position: Zooms the drawing area to the selected voice annotation's region.

® 4 -Retake: Allows for re-recording the selected voice annotation.

> Settings: Opens the "Voice Annotation Settings" dialog box, as shown in the image.

( voicemanager X

Show or hide all

© show all () Hide all

Default insertion type

© roint (_)Region () Object

Default Administrator
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5.45. Others

To implement the Voice Annotation feature, we utilize the WebView?2 control provided by Microsoft. This control is designed to
seamlessly embed web content into native applications, enhancing functionality and user experience.

There are some compatibility differences between different versions of the WebView2 control across various operating systems.
Therefore, we provide different solutions tailored to users' operating systems:

> Windows 10 and Windows 11: The system comes pre-installed with WebvView2. If your device lacks this control, the software will
automatically initiate the Microsoft installer when it gets online to quickly complete the installation.

> Windows 7 and Windows 8 (Online): Since the latest version of the Webview2 control does not support these two system versions,
the software will launch the Microsoft installer when the user's device is online and attempts to use the voice annotation feature in
GstarCAD 2025. This process ensures that users receive necessary support even on older operating systems.

> Windows 7 and Windows 8 (Offline): Without an internet connection, the software cannot launch the Microsoft installer to obtain
the Webview? installation package, temporarily disabling the voice annotation feature. We recommend users connect to the
internet to obtain the necessary installation files.

5.5.  BIM Data Editing New

BIM data can now be edited directly in GstarCAD 2025, providing enhanced efficiency for your design workflow!

Currently Supported BIM Properties for Editing:

Property Set Example Property Name Support

Type (%)
Building Element Type
Name
BIM

Description

Building

Story

O © & O O ©

Composition
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Overall Height

Micht definiert

Micht definiert

nten Filter

(%
Overall Width (X
Predefined Type (v
Operation Type (v)
Slab Common
Common BIM
. / (v
Properties
Thernal t
Lead b
_Pset_HName
Other Inherent BIM Hane
. i / v
Properties CADProperties
Eomp Element-ID
Name des merkmn. ..
Ursp
Raunname
Custom Property Sets / (v]

Note: Adding and deleting custom properties and custom property sets currently are not supported in GstarCAD.
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5.6. Break at Point New

You can enter BREAKATPOINT command to break the selected object into two
objects at a specified point.

If the specified point is off the object, it will be automatically projected onto it.

This applies to lines, arcs, and open polylines. Closed objects, like circles, cannot
be broken at a single point.

To break an object and create a gap, use the BREAK command and specify the gap
with two points.

5.7.  DWGUNITS New

Different projects or application scenarios may require different units. For example, architectural design might use meters, while
mechanical design might use inches. In GstarCAD 2025, the newly added DWGUNITS command allows you to change the units of
drawings to meet the standard size and annotation requirements of the drawing and avoid errors due to using different units.

You can enter DWGUNITS command or click Ribbon = Express = Modify » E_}DWG Units.
Command Line Prompts:

» (1) Enter units for length <3>: The default unit for imperial drawings is "3. Millimeters" and for metric drawings is "1. Inches". Six
common units are available.

Drawing units:

1. Inches

2. Feet

3. Millimeters
. Centimeters
. Decimeters

5. Meters

Enter unit for length <3>:
> (2) Enter linear display format<4>:

Drawing unit display formats:
1. Scientific
2. Decimal

5. Engineering

4. Architectural
5

. Fractional

Enter linear display format <45>:
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> (3) Enter linear display precision<4>:

Architectural linear display precision formats:
o qn
1. 1/2"
2. 174"
3. 1/8"
. 1/16"

5. 1/32"

5. 1/64"
. 1/128"
3. 1/256"

Enter linear display precision <43>:

> @) Scale objects from other drawings upon insert? [Yes(Y)/No(N)] <Yes(Y)>:

Controls whether objects inserted into the current drawing will be scaled according to existing objects. If set to "Yes," inserted
objects may be scaled to better match the current drawing environment.

> ) |Match INSUNITS to drawing units? [Yes(Y)/No(N)] <Yes(Y)>:

Ensure that the dimensions of objects match the scale of the drawing. If set to "Yes," inserted objects will be measured and
displayed using the same units as the current drawing.

> (6) Scale objects in current drawing to reflect change in units? [Yes(Y)/No(N)] <Yes(Y)>:

Controls whether the dimensions and scale of objects in the current drawing are adjusted to reflect the unit modification.

> 0 Include objects in Paper Space? [Yes(Y)/No(N)}] <Yes

Controls whether objects are included in pper space.

For example, when converting a drawing from imperial (inches) to metric (millimeters) units:

30



After executing the DWGUNITS command, the unit of the object is modified:

Line

General

Note: Different options may lead to different prompts. Just follow the prompts on the command line for accurate instructions.

5.8.  Application Manager New

. ERD S .- * 2D Drafting & GstarCAD 2025 Professional - [Drawing1.dwg]

Home Insert Annotation 3D Surface Mesh Layout View Manage Export Help BIM Express Application Cloud Note Collaboration

@ “®

Mechanical Architecture

ager DWG FastView WG FastView \pplications ~ Resources and Application

You can enter APPMANAGER command or click Ribbon 2 Application = Application Manager to open Application Manager. Itis a

unified system for plugin management. Users can search, enable/disable, and view details of modular applications within the Application

Manager, achieving the most suitable service configuration with minimal resource utilization.

7 Application Manager - X
A
Core [Frose ot sevc corere @G
Name ersion pdate Date Size tate le/Dis
& Drawing Format Expansion 101 2024-05-28 5.6MB Hibemate [ ¢
4B Bm 101 2024-05-28 480 MB Running q
Application Link 101 2024-05-28 18.9 KB Hibemate [ ¢
| Intetligent DIM 1.01 2024-05-28 347 KB Running q
¥ Express Tools 101 2024-04-01 938 Running [ ¢
< 3DNavigation 101 2024-06-06 372KB Running q
GstarCAD 365 beta 101 2024-06-13 134 MB Hibemate [ ¢
=) mdata 101 2024-05-28 118 1B Hibemate q

iii
S
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5.9. APl Innovative

GstarCAD continuously enhance the integrity and compatibility of
GRX, .NET, and LSP, ensuring that users' secondary development
programs run smoothly after migration, thereby reducing the cost of

secondary development migration.

In GstarCAD 2025, we support the use of Python on Windows to

extend the capabilities of the GstarCAD platform. With over 790

commonly used Python interfaces, we cover daily usage scenarios,

such as creating custom commands, custom graphics and entities, accessing and modifying various drawing data, and implementing
custom drawing and analysis algorithms. Users can leverage Python's powerful features for custom development and automation,
significantly expanding GRX functionality. This script-based invocation of GRX interfaces supports cross-platform development and

lowers the learning cost for new developers.
5.9.1.  System Environment Requirements

»  Python 3.11.8

»  Windows 10 and above

5.9.2.  Install Python

Download the installation package and install it as administrator, configure the options as below:

£ Python 3.11.8 (64-bit) Setup - X & Pythan 3.11.8 (64-bit) Setup - %

} Install Python 3.11.8 (64-bit) J Optional Features
Select Install Now to install Python with default settings. or choose 8 Documentation

Customize to enable or disable features. y . n files
= Install @ pip
C:\Users ms\Python\Python311 Installs pip. which can download and install other Python packages
Inc 8 tc/tk and |
Cre Installs tkinter and the IDLE development environment

8 Python test suite
e installation Installs the standard library test suite
tion and features 8 py launcher @ for all users (requires admin privileges)
Installs the global ‘py’ launcher to make it easier to start Pytho
PYthON g pitges whn ot e python
or or
. @ Add python.exe to PATH Cancel . Back Next Cancel

windows windows
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5 Python 3.11.8 (64-bit) Setup - X

Advanced Options
——— Install Python 3.11 for all users

8 Associate files with Python (requires the ‘py’ launcher)

B Create shortcuts for installed applications
Add Python to environment variables
Precompile standard library

Download debugging symbols

) Download debug binaries (requires VS 2017 or later]

Customize install location
C:\Program Files\Python311 Browse

python

Back Install Cancel

windows

Then finish the installation.

5.9.3.  Import Interface

Use the Import command in the Python file to import the secondary development package:
from pygcad.core import *
from pygcad.pygrx import *

pygcad.core includes Python-specific core interfaces such as the @command decorator;

pygcad.pygrx contains various types and methods corresponding to GRX interfaces.

5.9.4.  Register Custom CAD Commands

During development, when a user-defined function is decorated with @command, this function is automatically registered as a

command in GstarCAD, with the function name as the default command name. For example:

pygcad. core.runtime

pygcad. pygrx

*

and ()

0:

database = gcdbWorkingDatabase()

(status, blockTbl) = database.getBlockTable(GcDb.OpenMode.kForRead)
(status, record) = blockTbl.getAt(GCDB_MODEL_SPACE, GcDb.OpenMode.kForiWrite)
blockTbl.close()

line = GeDbLine(GeGePoint3d(e, ©, ©), GcGePoint3d(iee, 5 9))
(status, objId) = record.appendGcDbEntity(line)
record.close()
line.close()
Exception err:

geedPrompt (
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The function pyDrawLine() is decorated with @command(), automatically registering it as the GCAD command PYDRAWLINE.
If you don't want to use the function name as the command name, you can specify it in the decorator function command(). The
@command decorator is defined as follows:
def command(local_name="", global name="", group_name="", cmd_flags=0):
When local_name is empty, the name of the decorated function is automatically used as local _name. If global_name is empty, it

automatically uses local_name as global _name. If group_name is empty, it selects global _name as group_name. For example:

ocal name=

():

print(

This defines a custom command: PY_MY_CMD.

5.9.5. Loadin GstarCAD

For example, we used the secondary development interface to develop our own PYMKENTS command. Python file is: ents.py. After
running the command, the program will draw a line, a circle with a red linetype, and create a layer named ASDK_MYLAYER.

»  Open GstarCAD 2025, enter the APPLOAD command, the Load/Unload Applications dialog box will pop up:

(= Load/Unload Applications X

Loaded Applications  History List

File Path
3DxGst. .. WostarCaD 2025 0520%\plugi. ..
ai_cyl... D:\GETARCAD 2025 0520\SUFFO. .. Unload

D:
D:
2i3d fas D:\GSTARCAD 2025 0520%SUFFO. .. () Add to History
aligns... D:A\GETARCAD 2025 0520%5UPPO. ..
dyjt. lsp D:%\GETARCAD 2025 05200EUPFO...
elitoo... D:\GstarCaD 2025 0520%plugi. ..
D:\GstarCaD 2025 05204%plasi. ..
D:4WGETARCAD 2025 0520M\EUPPO. .. Startup Suite
D

expres. ..
goadll, . .
gead20. .. \GSTARCAD 2025 0520%5UFFO. ..
gehim. grx D:YWCstarCaD 2025 0520%plugi. .. ﬁ
godim. grx D:WOstarCaD 2020 0520%plugi. ..
gcExpe. .. D:\GstarCaD 2025 0520%plugi. ..
Overki... D:\GstarCaD 2025 0520%plugi. .. Contents

| Close Help

»  Click Load button and select the ents.py file, it will register the command automatically: PYMKENTS
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(7 Load/Unload Applications X

Loaded Applications History List

File Path Load
3DEGstarCal, grx D:WGstarCAD 2025 0520%plugi...

ai_cylinder. fas  D:\GSTARCAD 2025 0520\3UFFO. .. Unload
ai3d, fas D:\GSTARCAD 2025 0520%SUPFO. .. () Addto History
alignspace. fas D:WGETARCAD 2025 0520°\SUPFOD. ..

dyjt. lsp D:\GSTARCAD 2025 0520%SUPFOQ. ..

elitools. grx D:WGstarCAD 2025 0520%plugi...

ent rCAD Materia ..

SXpress. grx WGstarCAD 2025 0520%plugi. .. Startup Suite
zcad2025. 1lap D:4GETARCAD 2025 05Z0°\EUFFO...

geadz028doc. 1ep D:YGETARCAD 2025 0520%SUFFO. . . @
zchim. grx D:WGstarCaD 2025 0520%plusgl. ..

godin. grx D:4WGstarCaD 2025 0520%plugi. ..

gcExperience. grx  D:\GstarCAD 2025 0520%plugi... Contents...

|ents.py successfully loaded. Close Help

> Close the dialog box and enter command PYMKENTS, the program automatically runs:

To enhance drawing efficiency, we have optimized the DIM command for dimensioning. Now, you can enter DIM or click Ribbon

—>

Annotation » Dimension to create multiple types of dimensions, including Linear, Ordinate, Angular, Diameter, Arc Length,

Radius and Jogged Radius dimensions.
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When you hover the cursor over an object, the DIM command will automatically generate a preview of the appropriate dimension type.
Simply select the object or a point on the object, and click to place the dimension line to complete the dimensioning. This allows you to
create various types of dimensions with a single command, eliminating the need to frequently switch between different dimension

commands, thereby simplifying the workflow and speeding up the drawing process.

Command Line Prompt:
Select objects or specify first extension line origin or [Angular/Baseline/Continue/Ordinate/aliGn/Distribute/Layer/Undo]:
> Select Objects: Defaults to the appropriate dimension type for the selected objects and displays the corresponding prompts for

that dimension type.

Object Type Default Dimension Type
Line Linear dimensions
Circle Diameter dimensions
Arc Radius dimensions
Polyline Linear or radius dimensions, depending on the segment selected

> First Extension Line Origin: Specify two points to create a linear dimension.

> Angular: Creates an Angular Dimension displaying the angle between three points or two lines (similar to the DIMANGULAR

command).
®  Vertex: Specifies the point to use as the vertex of an angular dimension.
®  Specify first side of angle: Specifies one of the lines defining the angle.
®  Specify second side of angle: Specifies the other line defining the angle.
®  Specify angular dimension location: Specifies the quadrant and location for the arc dimension line.

o  Mtext: Edits the dimension text with the Text Editor contextual tab.
o  Text: Edits the dimension text in the Command window.

o textaNgle: Specifies the angle of the dimension text.

o Undo: Returns to the previous prompt.

®  Undo: Returns to the previous prompt.
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> Baseline: Creates a Linear, Angular, or Ordinate Dimension based on the first extension line of the previous or selected dimension

(similar to the DIMBASELINE command).

Specify first extension line origin: Specifies the first extension line of the base dimension as the extension line origin for the
baseline dimension.

Specify second extension line origin: Specifies the next edge or angle to dimension.

Select: Prompts you to select a linear, ordinate, or angular dimension to use as the base for the baseline dimension.

Offset: Specifies the offset distance from which the baseline dimensions are created.

Undo: Undoes the last baseline dimension created.

> Continue: Creates a Linear, Angular, or Ordinate Dimension from the second extension line of a selected dimension (similar to the

DIMCONTINUE command).

Specify first extension line origin: Specifies the first extension line of the base dimension as the extension line origin for the
continued dimension.

Specify second extension line origin: Specifies the next edge or angle to dimension.

Select: Prompts you to select a linear, ordinate, or angular dimension to use as the base for the continued dimension.

Undo: Undoes the last baseline dimension created.

> Ordinate: Creates an Ordinate Dimension (Similar to DIMORDINATE command).

Specify feature location: Prompts for a point on a feature such as an endpoint, intersection, or center of an object.

o  Specify leader endpoint: Uses the difference between the feature location and the leader endpoint to determine
whether it is an X or a Y ordinate dimension. If the difference in the Y ordinate is greater, the dimension measures the
X ordinate. Otherwise, it measures the Y ordinate.

o  Xdatum: Measures the X ordinate and determines the orientation of the leader line and dimension text.

o  Ydatum: Measures the Y ordinate and determines the orientation of the leader line and dimension text.

o  Mtext: Displays the Text Editor contextual tab to edit the dimension text.

o  Text: Edits the dimension text at the Command prompt.

o Angle: Specifies the angle of the dimension text.

o Undo: Returns to the previous prompt.

Undo: Returns to the previous prompt.
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> Align: Aligns Multiple Parallel, Concentric, or Same Datum Dimensions to a selected base dimension.
®  Select base dimension; Specifies a dimension to use as the basis for the dimensions alignment.

o  Select dimensions to align: Selects the dimensions to align to the selected base dimension.

> Distribute: Specifies the method to distribute selected isolated linear or ordinate dimensions:
®  Equal: Equally distributes all selected dimensions (requires a minimum of three dimension lines).

®  Offset: Distributes all selected dimensions at a specified offset distance.

> Layer: Assigns new dimensions to a specified layer, overriding the current layer.
®  Enter layer name; Specifies the layer by entering its name

®  Enter “. " Uses the current layer

®  (bject: Specifies the layer by selecting an object of it
®  Enter “? " Lists all the layers in the current drawing
®  eXit: Returns to the previous prompt

> Undo: Reverses the Last Dimension Operation.

> Handling Overlapping Dimensions:
®  Move Away: Arranges the existing dimension and the newly inserted dimension into a baseline dimension type.
®  Break Up: Splits the existing dimension into two dimensions, arranging them into a continued dimension type.
®  Replace: Deletes the existing dimension and replaces it with the new one.

®  None: Inserts the new dimension on top of the existing one.

Note: If Intelligent DIM is disabled in the Application Manager, executing the DIM command will switch to the normal DIM mode. For

more details, please refer to the DIM1 command.

38



5.11. 3D Model Import/Export /mprovement

On the basis of IFC Import, you can now export IFC files and import RVT files with complete BIM data, and STEP/IGES module will be

included in GstarCAD installer, you don't need to install it separately.

5.11.1. IFCEXPORT

On the basis of IFCIMPORT, now you can enter IFCEXPORT command or go to Ribbon  BIM » EEXDOTT IFC files to export

drawings in IFC format with their complete BIM data.

(3 Export Data

X

v|C:'E1E] View ¥

Save in | GstarCAD 2025 Drawings & Files
I =
e
=E |
__pycache__ AC20-Institute-Var-2.ifc Villa.ifc
File name: ‘Drawing‘l ifc ~ | [ Save ]
Save aslype: IFC4{".ifc) v Cancel
IFC2x3(*".ifc)

Besides, there’s also a newly added system variable for handling IFC files in GstarCAD:

System Variable Description Value Value Description
Hides entities in the IFC drawing that
Controls the display and hiding of entities 0 are not associated with building
SHOWALLIFCENTITIES in IFC files that are not associated with entities.
building entiies. Displays entities in the IFC drawing
1 that are not associated with building

entities.
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5.11.2. RVTIMPORT

You can enter RVTIMPORT command or go to Ribbon  BIM » Open RVT files to import drawings in RVT format with their

complete BIM data.

(7 Select Files X
Look in | GstarCAD 2025 Drawings & Files v‘ <G 10 view ¥
e Preview:
B
-
]
__pycache_ i RVT FILET1.rvt RVT FILE2.rvt
Find File...
Locate
File name: [RVT FILELmt ~] [ open [+]
Files oftype |Revit File( i i2) | Cancel

5.11.3. IGES/STEP Module

IGES/STEP will be included in the GstarCAD installer, there’s no need to install it separately, and you can manage it along with other

modules in the Application Manager.

The File Tab Bar and Layout Tab Bar in GstarCAD 2025 have been updated with new appearances.

5.12.1. File Tab Bar

In GstarCAD 2025, the File Tab Bar has been enhanced

=— | Drawingl* | Drawing2 B Drawing3 3 —I—

with "New" and "List" buttons, making it more convenient
to create, open, and switch between drawings directly

from the file tab bar.
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Additionally, new icons has been added next to the file name to indicate when a file is locked or has been modified, providing a clearer
display of the file status. The new appearance and display method also take up less space.

»  The drop-down list allows you to switch drawings, create new ones, open, save, and close drawings.

=— | Drawingl1* e

Drawing1* Ll

D - Save
rawing.Z
A - Save As...

& Drawing3 Save All
Close
Close All
Close Others

MNew Drawing
MNew

Open -
Audit

Drawing Properties
Close All Open File Locatior

Save All

SO NP+ o

> Clicking the "New" button allows you to directly create a new document, and the right-click

menu provides options for creating and opening drawings. B nNew
& Open

5.12.2. Layout Tab Bar

The new Layout Tab Bar is similar with the File Tab Bar, they both include a "List" button.

New layout

From template...

Page Setup Manager...

Bl Select All Layouts

Dock above Status Bar
Dock Inline with Status Bar
Maodel

Layoutl

Layout2

Layout3

— | Model | Layoutl | Layout2 Layout3 —|—

Other than being positioned above the status bar, now or the Layout Tab Bar could also be aligned with it to save screen space.

= | Model | Layoutl | Layout2 Layout3 Layoutd | Layout5 | Layouté | Layout? | Layoutd | —

= | Model | Layouti | Layout? Layout3 Layoutd | Layout5 | Layout6 | Layout? | Layouts | =
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The Lasso selection allows you to create an irregularly shaped window or crossing selection set. The implementation of 1asso selection
can not only replace frame selection to select simple objects, but also solve the problem of difficult selection of some complex objects

using frame selection.

5.13.1. How to Use Lasso Selection

To use the lasso selection, just hold the mouse button down while dragging the mouse to create the lasso. When you release the mouse

button, the lasso is completed.

5.13.2. Lasso Selection Modes

Lasso selection provides three modes: Window Lasso, Crossing lasso and Fence 1asso, you can press the spacebar to cycle through the
lasso modes.
> Window Lasso Selection: Hold the mouse button down and drag the mouse from left to right, only the objects that are completely

enclosed in the selection area are selected.

> Crossing lasso selection: Hold the mouse button down and drag the mouse from right to left, the objects enclosed in and that are

crossed by the selection area are selected.

42



> Fence Lasso Selection: Specify points to define a fence, the objects that pass through the fence will be selected.

5.13.3. System Variable Compatibility

GstarCAD optimizes the PICKAUTO system variable to be consistent with ACAD.

43

System Variable Description Value Value Description
Selects an object by clicking. It only
7.4 Sstores the value and the value will not
_ o _ take effect.
Used in conjunction with lasso selection
to control the automatic windowing for Selects an object by clicking. Turns off
PICKAUTO object selection. This system variable is 0 automatic window and crossing
also used to control the opening and selection.
closing of the lasso. , . .
Starts a window or crossing selection
1 if the cursor is not directly over an

object when clicking;




Selects an object directly by clicking if
the cursor is on the object, selection
complete.

Starts a window or crossing selection
2 gven if the cursor is directly over an

object.

Starts a window or crossing lasso

selection if the cursor is not directly

over an object when clicking;

Selects an object directly by clicking
and dragging if the cursor is on the
object, selection complete.

Note: To specify more than one option, enter the sum of their values. For example, entering 5 specifies the bitcode 1 and 4 options.

Value Description
3 The combination of bitcode 1 and bitcode 2 which has the same effect as bitcode 2
5 The combination of bitcode 1 and bitcode 4 which has the same effect as bitcode 4
6 The combination of bitcode 2 and bitcode 4
7 The combination of bitcode 1, 2 and 3 which has the same effect as bitcode 6

Summary:

> When the value of PICKAUTO is 0, the objects can be selected only by clicking.

»  Whenthe value is 1, 2 or 3, it's window selection.

»  When the value is 4, 5, 6 or 7, it’s the window selection and crossing lasso selection (To specify a window selection area, click
and release the left mouse button, move the cursor, and click again to finish; To create a lasso selection, click, drag, then release

the left mouse button to finish).
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5.13.4. Window Selection Improvements

You can directly specify the diagonal point when making a frame
selection. The options of fence selection (F), window polygon
selection (WP), and crossing polygon selection (CP) have been
added. You can switch to fence selection or polygon selection

mode by entering the keywords.

Meodel /| Layoutl / Layout2 - +

nd

ommand ify opposite corner or [Fence/WPolygon/CP

HHE 5L C

5.13.5. Selection Cycling

GstarCAD 2025 supports Selection Cycling during command execution, allowing users to filter and select the desired objects from

overlapping entities.

G Selection Cycl...

: Hatch
7 Hatch
Command: @Nore |

Command: MOVE

elect object:

= Model Layoutl | Layout2 | -
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In GstarCAD 2025, the UNDO command supports the combination of zooming and panning operations as well as layer operations. After

combination, multiple zooming, panning and layer operations can be undone at once, eliminating the need for repeated operations.

> There are two ways to pan: input the command PAN or press down the middle mouse button and drag to pan (IntelliPan)
> Similarly, there are two ways to zoom: input the command ZOOM or scroll the middle mouse button. (IntelliZoom)

The combined results are detailed in the table below (completely consistent with ACAD):

. Combined Result
Scenario o . .
(View in the UNDO operation record on the quick access tool bar)

PAN multiple times in a row Pan
IntelliPan multiple times in a row Pan
Z0OM multiple times in a row Zoom
IntelliZoom multiple times in a row Zoom
Consecutive PAN + IntelliPan Pan
Consecutive ZOOM + IntelliZoom Zoom

Consecutive PAN + IntelliZoom/ Pan and Zoom

Z00M+ IntelliPan
Consecutive PAN + ZOOM Pan and Zoom
Consecutive IntelliPan + IntelliZoom Pan and Zoom

> After performing layer-related operations in the Layer Properties Manager (such as create a new layer, switch layers, freeze layers,

lock layers, etc.), the UNDO operation record on the quick access toolbar will be combined as "Layer".

The setting is stored as a bitcode using the sum of the following bitcode values:

System Variable Description Value Value Description

Displays the options used in the UNDO 0 UNDO s tumed off

UNDOCTL command. (read-only variable)

1 UNDO is turned on
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2 Only one command can be undone

4 Auto is turned on

8 A group is currently active

Zoom and pan operations are grouped
as a single action

Layer property operations are grouped
as a single action

> Support Changing Related Options in OPTIONS Dialog Box

(> Options X
Current profile: <<Unnamed Profile=> i@ Currentdrawing Drawingl.dwg

File  Display OpenandSave PlotandPublish UserPreferences Draw Selectionset Profiles

Windows Standard Behavior Priority for Coordinate Data Entry
Dgub\e click editing "i"ﬁunnmg objectsnap
Shortcut menus in drawing area () Keyboard entry

Right-click Customization... o Keyboard entry except scripts

Insertion scale Associative Dimensioning

Default settings when units are setto unitless: =
& & Make new dimensions associative

Source content units:

Millimeters ~ Undo/Redo
s g Qombme zoom and pan commands
Millimeters P Cnmb\nelayerpmpeﬂy change
Block Editor Settings...
Field
Display background offields Lineweight Settings..
Field Update Setiings Defaut Scale List.
Help

General Options Accsss online Help when available

Hidden Messages Settings
Display OLE Text Size Dialog

Cancel Apply Help

Batch Plot in GstarCAD 2025 has been comprehensively improved based on user feedback, making it applicable to more scenarios.
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(> Batch Plot Setup

Specify batch setup

Filter Base: layer ~ 0 ~
[The number of entities of the selected set before fitter can't be less than 1

Exclusion Setting:Automatically excluded ifthe area is less than the specified
proportion of the maximum frame

Plot Setup _Opfions

Plotter Name OneMate (Deskiop) ~
Paper Size Envelope Manarch ~
Plot scale O Fitto paper OCustom: 1. 100
Plot Styls Mons v
Drawing Orientation: @) AutomaticRotate (O Landscape () Portrait
Plot offset Ocenter () Offset il 0
File Setup

Drawingl _ Il

ChlsersiAdministratofDocumentst, Source file path

Overarite when

Juplicats Backup duplicate

Processing Options

Selectfrom draming

Specify frame

DP\D(ID File Multi-sheet file
Murnber of copies : 1

Shade Plot: Asdisplayed
P\nt Linewiciths

() Plotwith transparency

() Plot Stamp

2
Browse:

Automatic number

Plot Order. — — —
—— e I/I,ﬂl bl\l — —_— I\Iq FI/I Check and Adjust
Output Options ) Flotto layout ) Splitinto DWG () Splitinto DixF OFlot
oK Cancel Help

The main enhancements are as follows:

> Specify batch setup

Filter Base: In addition to blocks, layers, and polylines, it now supports external reference (only displays this option when

there is Xref in the current drawing).

Specify batch setup

Filter Base:

laver w0

The number of e

Exclusion Setting:
proportion of the

Specify frame: In the old versions, "Specify frame" only supported a single selection, now there are some enhancements:
o After clicking "Specify frame", multiple selections are now supported.
o  Traverse option is provided. When the selection prompt appears,
right-click to choose to traverse the model, layout, or both, as shown in
the picture. After selecting the corresponding option, it will directly

traverse all objects in the model and/or layout space, filtering the

blocks

et before fitter can't be less than 1

drawing frames that meet the conditions.
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Selectfram drawing

Specify frame

Enter

Cancel

~ Current Model
All Layouts

Layouts + Model Space

Pan

(€] Zoom

E QuickCalc




®  [xclusion Setting: When filtering, some graphics might be mistakenly identified as frames. This can be preliminarily screened

through a ratio. If the area of certain filtered frames is smaller than a certain percentage of the maximum fram, they will be

removed from the filtering results.

Specify batch setup

Filter Base: lanyer w0 hd Selectfram drawing

The number of entities of the selected set befare filter can't be legs than 1 Specity frame

Exclusion Setting:Automatically excluded if the area s less than the specified b %
proportion of the maximum frame

> Plot Setup & Options
The Plot Setup and Options are basically the same as those in the regular plot dialog box, but they have been filtered and rearranged.
Adjustments have been made based on user needs. If the current model or layout has a default page setup, the settings of the current

space plot configuration will be directly read. If there is no page setup, all settings can be completed in this dialog box.

Flot Setup Options

Flotter Mame: OneMote (Deskiop) ~ [ ]Plotta Fils tulti-sheet file
Faper Size: Emvelope Manarch e MNumber of copies: 1

Flot scale: O Fitto paper OCustor: 1 100 Shade Flot  Asdisplayed -
Plot Style: Nane v Plot Linewidths

Drawing Orientation: @ Automatic Rotate () Landscape () Portrait [ Plotwith transparency

Flot oftset: © Center () Dffset il il [ ]Plot Stamp

®  Plotter Name: It will directly read the default plotter from the "Options" dialog box. This eliminates the need for additional
configuration. If users frequently use the same printing device, they can simply set the default output device in the "Plot and
Publish" tab of the Options dialog box.

®  Plot to File: When selecting PDF, DWF, or other printing devices, "Plot to File" is automatically checked. When selecting a

physical printer, it is not checked, but users can choose to check it. If checked, it will plot and output to PLT.

®  Multi-sheet file: This option is activated only when the PDF plot driver is selected. During plotting, a multi-sheet PDF file will

be automatically generated instead of separate PDF files.
®  Number of Copies: When users need to use a physical plotter, they can set the number of copies, with the same functionality

as the regular plot dialog box.
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®  Drawing Orientation; The default is the "Automatic Rotate" option from the old versions. Horizontal and vertical options have
been added. If horizontal or vertical is selected, the graphic will be forcibly oriented accordingly.
®  Plot Options: Shade Plot, Plot Linewidths, Plot with transparency, Plot Stamp are the same as those from the regular plot

dialog box.

> File Setup

If user selects drivers like PDF and DWF, or selects a physical plotter device and then checks "Plot to File”, file options can be set.

File Setup

Frefix Name: Drawingl_ Sl 1 Digit: 2
numkber:

Sawe Path: Chlsers\AdministratonDocumentsy, Source file path w Browse...

Duplicate processing options: () Overarita when () Backup duplicate © Automatic number

“~ duplicate

®  Prefix Name: The current drawing's filename is read as the default prefix, and users can edit it according to their needs.

®  Starting Number: Users can set a starting number, facilitating batch plotting.

®  Digit: Determine the number of digits for the numbering. For example, if 2 digits are specified, the numbers will be 01, 02, ...
10, 11. If 3 digits are specified, the numbers will be 001, 002, ..., 010, 011.

®  Save Path: The source file path is displayed by default, and users can edit or add subdirectories.

®  Source file path drop down list: Provides three options: Source file path, Source file path\PDF, Options default saving path.

File Setup
Prefix Name;  Drawingl_ SR 1 Digit. 2
nurmber:
Sawve Path: ChillsersiAdministrato,Documentsy, Source file path Browse...
Source file path
Duplicate processing options; ) Overwrite when g5 ource file pathiPDF i
. ¥ gor ~ duplicate (U Boptions default saving path  fomatic number

> Processing Options

Processing Options

SEMNE=NM

Output Options: () Plotto layout ) Splitinto DWG () Split inta DXF © Fiot

Flot Order: Check and Adjust




®  Plot Order: Nine sorting methods are provided.

o Eight of these are based on different directions: top left to bottom right, bottom left to top right, top left to bottom right,
top right to bottom left, top right to bottom left, bottom right to top left, bottom left to top right, and bottom right to top
left.

o Another method is to sort according to the selection order (suitable for multiple selections). By default, the first button
(top left to bottom right) is selected. The background of the selected button changes to red.

® (Checkand Adjust; Clicking the Check and Adjust button will bring up a dialog box displaying the Serial Number, Drawing

Size, Plot Scale, and Paper Size information of the filtered frames:

Exclusion SetingAutomatically excluded ifthe area s less than the specified 5 %

G Batch Plot Adjustment

Preview Delete

Serialnumber  Filename  Drawing size  Plotscale Paper size Drewing orientation Notes

pe M
Drewing3. 00 Fittopaper  Envelope Monarch PorraitaNot upside-down
Drewing3 00 Fittopaper  Envelope Monarch  LandscapedNot upside-down

Drawing3. 00 Fittopaper  Envelope Monarch  Landseape&Notupside-down

Drawing3 00 Fittapaper  Envelope Manarch  Landseape&Not upside-down

Drewing3.. 00 Fittopaper  Envelope Monarch  Landscape&Notupside-down
10 Drewing3. 00 Fittopaper  Envelope Monarch PorraitaNot upside-down
il Drewing3 2x2 Fittopaper  Envelope Monarch PorraitaNot upside-down
12 Drauwing3 00 Fittopaper  Envelope Monarch  Landscape&Notupside-down
3 Drawing3. 02 Fittopaper  Envelope Monarch PorraitdNot upside-down
1 Drawing3 00 Fittapaper  Envelope Manarch  Landseape&Not upside-down

2
3
4
5
6 Drawing3 00 Fittopaper Envelope Monarch  LandscapeNotupsidesdown
7
8
9

15 Drewing3.. 00 Fittopaper  Envelope Monarch  LandscapedNotupside-down
16 Drewing3 10 Fittopaper  Envelope Monarch  LandscapedNotupside-down
7 Drawing3 00 Fittopaper  Envelope Monarch PorraitaNot upside-down
18 Drauwing3 02 Fittopaper  Envelope Monarch PorraitiNot upside-down

Output Optians: (OPlotto layout O Splitinto DWG (O Splitinta DXF OFIt I

o When the dialog box pops up, the filtered frames will be highlighted in the drawing, and the numbers will also be
displayed, which correspond to those in the dialog box. Users can determine whether the filtered drawings are correct
by checking their sizes or by clicking Preview. If some of the filtering results are incorrect, users can click Delete, and
the remaining items will be automatically renumbered.

o Additionally, users can adjust the Plot Scale, Paper Size, and Drawing Orientation here, meeting the need for plotting
drawings of different sizes in one batch.

®  Qutput Options: Four options are provided: Plot to Layout, Split into DWG, Split into DXF, and Plot.

o Printto Layout: Previously in the dropdown list, is now listed separately.

o  Splitinto DWG: A new option that allows the filtered frames and content to be saved as separate DWG files.

o  Splitinto DXF: Another new option that allows the filtered frames and content to be saved as separate DXF files.

o  Plot: Equivalent to the "OK" button in the old dialog box and is the default option.
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The QRCODE command now supports command line mode -QRCODE, facilitating the creation of QR codes via scripts or programs.

& 2D Code Creator X

Input Text:

GstarCAD| et
Gstarsoft Co.,Ltd

Already entered:27/500 Clear data
Pick Object
2D Code Parameters
Text Block 2D Code
Version: 2 v
R bR Error Level: L (7%) w
Drawing Name Date and Time
D 9l D_ Code: QRCode ~
Scale: 1 1:1 ~
Iag=y - | Delete Size: 33%33
Command:
Copy barcode Save Image Exit

= Model Llayoutz |

After copying data from an Excel worksheet to the Windows clipboard, you can enter the PASTESPEC command, in GstarCAD 2025, the

"Paste Link" method has added a "DWG Entities" option.

Paste Special X

Source:  SheetlIR1CT:R4C2
As: Cancel
() Paste Microsoft Excel Worksheet
T DWG Entities
OPaste Link Display As Icon
Result

Insers the contents ofthe clipboard into your
document as DWG Entities. The data is linked to the
source file so that changes to the file will be reflected
in your document.

If you select the “DWG Entities” option, the metafile graphics in the Clipboard are converted to GstarCAD objects and copied to the

current drawing. If the metafile graphics are not converted, the metafile is displayed as an OLE object.
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After inserting the data, selecting the table enables you to edit the row and column spacing of the table object, as well as modify the

contents of the table. A data link will also be automatically created and can be updated using the DATALINKUPDATE command.

aaaaaaaaaaaaa

e — — 1 |windows 5|
B vindows 2 |doors 8!
doors 3 |tables 2|
tables 4 |chairs 4

ichairs &

6

T

8

9

10

11

GstarCAD 2025 introduces key updates to enhance licensing management and security

> License Expiration Reminder
® Title Bar Reminder: If you are using a free-trial version, next to the product name, GstarCAD 2025 will display the remaining
days of the trial. After expiration, it will display "Expired".
®  Popup Reminder: When the license is due to expire in 1, 7, 30, or 60 days, a popup reminder will appear each time the

software is opened on those days, prompting the user to renew the subscription in a timely manner.

The software license will expire in 30 days! Please contact
your local distributor to renew.

(") Do not show it again this time oK

Note: If "Do not show it again this time" is clicked, the popup will not appear again for the rest of the day.
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Online Number: In GImServer » License Manager, you can view the current number of online users, making it easier for

administrators to view usage details and make informed decisions about license purchase.

& Network License Manager b

License manager

License Key Product version Expira.. License Status  No... Bo...] Online Numbel Refrash

1111-1111-1111-1111-1111-1111... GstarCAD,Professional,2025,zh-CN;z... Perma... Fully Trusted 5 0 1} Online Activate
2222-2222-2222-2222-2222-2222... GstarCAD,Standard,2025,zh-CN;jzh-...  20-Oc... Fully Trusted 3 0 0

Manual Activate

Online Return
Manual Return
Online Repair
Manual Repair
License Details
Borrowed Detais
Statistical Details

Close

Statistical Details: Supports custom queries for usage information of license users, including userame, quantity, usage time, etc.

G Network License Manager

License manager

License Key : = - - E— o
E401-£907-6D01-0100 Detalls "
Online Activate

[Today | [ 6172004 | - [ 6/17/2024 | Query —

ot Madme tame | dt=d § Durd.... | Durstion Online Return

Administrator GstarsoftLuke 2025 1 00:36:21
Manual Return

Online Repair
Manual Repair
License Details

Borrowed Detals

Statistical Details

User Statistics: 1

Close

USB Standalone Dongle Upgrade: In GstarCAD 2025, the USB standalone dongle has been upgraded to the Moway dongle. Both
client encryption and the write-lock tool have been correspondingly upgraded to support the Moway dongle and include relevant

descriptions.

Note: Users who own the original Living dongles will not be affected and can continue to use them normally. During use, there will

be corresponding guiding prompts.
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